
www.hrw.com 800.hrw.9799HOLT, RINEHART ANd WINSTON

technology
instructions
technology
instructions

2008



Technology Coordinator Instructions.....................3

Technology Components.........................................4

State Resources........................................................5

One-Stop Planner......................................................6

Exam View Test Generator.......................................9

Mind Point Quiz Show............................................14

Holt Online Product Registration..........................15

Novel Wise and Writers’ Lives...............................17

Holt Online Assessment.........................................18

Online Essay Scoring.............................................21

Calendar Planner.....................................................23

Holt Puzzle Pro........................................................25

Virtual File Cabinet..................................................26

Table of
     Contents



HOLT Language Arts  Technical Support 800.323.9239 

Dear Technology Coordinator,

Thank you in advance for your technical assistance with the upcoming technology in-
service training. We will be working with the Elements of Literature One-Stop Planner®, 
which consists of two CD-ROMs containing all of the teacher resource materials for the 
program. The CD contains the installation software for the ExamView® Test Generator 
program, Holt Calendar Planner, and Holt PuzzlePro®. For your convenience the CD 
also includes a version of Adobe Acrobat Reader®, but you may wish to use a newer 
version that can be found on Adobe’s web site.

For this training, teachers will need to be able to view the CD-ROM to see the .pdf 
files of the print ancillaries and access the test generator and the banks that ExamView 
will load at installation. All software included is designed to be compatible on both 
Macintosh® and Windows® platforms.

Teachers and students will also need access to our educational web site, go.hrw.com, 
where they can access literary links, author biographical information, projects and 
activities, and interactive writing and vocabulary activities. 

We will also be registering teachers for online privileges on the Holt Online Learning 
web site. Registering will allow teachers to set up classes that will assign user names 
and passwords to their students. Students then may access the online textbooks and 
Holt Online Assessment. These resources are hosted on our web site; therefore, all you 
will need is Internet access to the site my.hrw.com. In order for students to view the 
online books and use interactive lessons, the following plug-ins should be available to 
the browser: Flash 6.1+, Shockwave 8.5.1+, Quicktime 5+, Adobe Acrobat Reader. 

Should you need assistance with any aspect of installing the software, please contact 
Technical Support at 800.323.9239. They are available Monday through Friday from 
6:00 am to 12:00 am (EST) and on Saturday from 8:00 am to 5:00 pm (EST).  

Thank you,

The Holt, Rinehart and Winston 
Educational Consultant Team

2

3



3

Component DesCription ConneCtion to Core Content

Audio CDs Audio CDs of most of the 
selections

Dramatic readings by professional actors of most of the reading 
selections; key selections read in Spanish; and summaries for 
most selections in Spanish.

Holt Calendar planner Curriculum mapping tool Calendar making tool linked to print ancillaries and lesson 
plans. Automatic pacing suggestions based on field testing. Fully 
editable so that teachers may adjust lesson pacing as needed. 
Note: Install this from the State Resources folder on One Stop 
Planner® CD.

Fine Arts transparencies Transparencies Classic and contemporary art that complements literary selections 
and helps students to make cross-curricular connections.

Holt interactive spelling 
CD-rom (Grades 6-8)

Student tutorial for spelling 
strategies

Game-like practice and review activities for grades 6-8; full 
audio support for instruction; lessons progress so that students 
practice spelling in context of proofreading to assure relevance 
to the writing process.

one-stop planner® 
CD-rom

CD with core resources, lesson 
plans, test generator, calendar 
tool, and puzzle maker

Digital copies of all print ancillaries, links to online resources 
on go.hrw.com, links to test generator banks, calendar planner, 
and puzzle maker. ExamView® Test Generator tool contains all 
test items in editable banks and is capable of uploading tests to 
HRW web site. Question banks are correlated to core content 
objectives and state standards.

Holt online Assessment Online record keeping 
system for students’ work and 
teachers’ assignments

A tool for monitoring student progress through student mastery 
and recording and analyzing scores. Keeps records of student 
scores on diagnostic and summative tests; keeps records of 
student notebook entries; allows teachers to post ExamView® 
generated tests.

premier online edition Online digital version of print 
Student Edition

Online Student Edition with interactive features such as a student 
notebook, audio and video links, and author links.

Holt online essay scoring Online writing practice System that automatically scores student essays on-line.

powernotes™ CD-rom PowerPoint® presentations Fully editable PowerPoint® presentations illustrate warm-ups, 
additional examples, and quizzes.

puzzlepro® Vocabulary activities Puzzle making tool with links to grade level vocabulary banks. 
Editable.  note: install this from the “installers” 
folder on one stop planner® CD.

Visual Connections DVD DVD Short video clips of author biographies, interviews, historical 
summaries and cross-curricular connections.

go.hrw.com Monitored internet site Author biographies; literary elements information; interactive 
writers’ models; interactive vocabulary-building activities; cross-
curricular projects connected to the literature; video clips from 
historical speeches; research/media literacy activities.

www.hrw.com Corporate Internet site Contains product catalogs and additional teacher information.

Technology
    Components
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State-Specific Resources
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DownloADing lesson plAns witH stAte objeCtiVes

Before downloading, create a folder in the location where you save your lesson plans—a location where you 
will know where you put it (for example, in My Documents, create a file called Lesson Plans).

 1. From your One-Stop Planner®, click the gold State-Specific button on the opening screen.

 2. From the map, click on your state.

 3. From the Lesson Plan menu, choose either 
      Macintosh or windows.

 4. Choose Save and select the folder you have just created. Click Save again. After 
      the .zip file has downloaded, click Open Folder. You will have a zipped folder 
      called Lesson (or one similar to the title pictured).

 5. At this step, operating systems differ. For windows XP, right-click and choose 
      winZip, Extract from the drop-down menu. For Macintosh instructions, refer to 
     your help menu or call Technical Support to assist you if you do not know how to 
     extract a zipped file.

 6. A new file folder has been created (i.e.: EOLit07 First Course LPs). This 
     folder contains subfolders with new .pdf and editable Work, Works, and Claris 
     lesson plans. These lesson plans have the state objectives in them. They are NOT 
     connected to the editable lesson plans from the One-Stop Planner®, however. If you  
     want to use these after previewing from the One-Stop Planner®, you will need to   
     manually open the individual lesson plan.

DownloADing eXAmView® witH stAte objeCtiVes
 1. From the ExamView Downloads, choose either Macintosh or windows.

 2. Choose Open. This could take some time. You may also choose to Save and then open the file later.

 3. After the .zip file has downloaded, you will have three files.

 4. Choose Setup.exe.

      This will install a new version of ExamView® with your state objectives. You will find the state  
      objectives on the answer key of the tests you create.

**Download other state correlated programs from this site.
5



HOLT Language Arts  Technical Support 800.323.9239 

One-Stop Planner Guide

one-stop plAnner® CD-rom teACHing resourCes

+ Printable student worksheets and tests; teaching transparencies
+ Editable lesson plans with links to collection resources 
+ Test Generator with ExamView® Software
+ Answer Keys
+ A direct launch to internet sites that contain valuable teaching and learning resources, including  
   go.hrw.com and state-specific sites. 

+ Holt PuzzlePro® puzzle maker 
+ Holt Calendar Planner with preset pacing guides

Note: The collection resources are divided up between two CDs. Each CD has the installation package 
available.

instruCtions For tHe instAller DisC
1. After inserting CD into CD drive, the disc should automatically open.  If it does not, you will     
    need to open “My Computer” and then double-click to open the EOLit disc. Open the  
    folder “Installers” from either the “List” or “Icon” view.

“LIST VIEw”                                                       “ICON VIEw” 

 

2. There are five programs you will need to install: ExamView®, Holt Calendar Planner, 
    PuzzlePro®, Quick Time, and Adobe Reader.

 

4
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instruCtions For using tHe one-stop plAnner® CD-rom
1. After installing all of the programs that you need, access the one-stop planner teacher resources   
   by double-clicking “One-Stop.pdf” in the “list” or “icon” view:

“LIST VIEw”                       “ICON VIEw”                   

 

2. After you open the “One-Stop.pdf”   
   file, click on the “Go to One-Stop Planner” button.

 

3. Notice that you will be able to access the first half of the  
    collections on the first disc, and the second half on the  
    second disc. Use single clicks to open resources from this  
    point on.

5

One-Stop Planner Guide
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HOLT Language Arts  Technical Support 800.323.9239 

One-Stop Planner Guide
4. When you open a collection, note that there will be more than one window for each collection.  

 

At the collection level, you can access, with a single click, the literary and informational selections and all 
of the collection resources such as the collection diagnostic and summative tests, the literary elements lesson, 
writing, listening and speaking workshops resources, collection review resources and advanced student 
resources, as well as miscellaneous collection resources such as daily language activities, Holt Reader and 
grammar worksheets.

5. After you open a collection, select and single click on a selection. At the selection level, you will find editable   
    lesson plans, adapted readings, graphic organizers, vocabulary worksheets, media support, ready-to-print tests and  
    the test generator. 

       Note: In order to use state-specific resources, follow the instructions on the next page. 
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HOLT Language Arts  Technical Support 800.323.9239 

ExamView®

  Test
    Generator

The Exam View® Test Generator lets you quickly create paper, Internet, and online (LAN -based) tests. You can enter your 
own questions and customize the appearance of the tests you create.  Here are some of its features:  

	

	 +	 A “wizard” to guide you through the steps to create a test in less than five minutes

	 + Five ways of selecting test questions from the Holt test banks or ones you create:
    • From a list
    • Random selection
    • By criteria (difficulty code, objective, etc. --if available)         
    • While viewing questions
    • All questions

	 + Edit questions or add an unlimited number of questions with 13 question types to choose from (multiple choice, etc.)

 + Change the order of questions, scramble the choices in multiple choice questions

 + Print multiple versions of the same test with corresponding answer keys

 + Format the test to match a pre-defined format, such as a particular state test layout, with a single click

 + Numerous test layout and printing options: e.g., specify the layout of a test to conserve paper

  + Modify tests for students with IEPs

 + Organize matching questions in a one or two-column format

 + Print an answer key strip and/or bubble sheet for easier test grading

 + Print a test with or without space for students to record their answers

 + Print a comprehensive answer sheet annotated with text objectives and state  standards

 + Online (Internet-based) testing

 + Create a test that students can take on the Internet using a web browser

 + Publish tests directly to the Holt Testing Server 

14
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test builDer bAsiCs
If you want ExamView® to choose questions randomly from one or more question banks, choose the QuickTest wizard 
command to create a new test. Then, follow the step-by-step instructions to:

 1. Enter a test title.

 2. Choose the question bank(s) from which to select questions. 

 3. Identify how many questions you want on the test. The QuickTest wizard will automatically create a new test   
  and display it on the screen. You can then print the test as-is, remove questions, add new questions, or edit any  
  questions.

using tHe QuiCktest wizArD
 1. Click or choose QuickTest wizard from the File menu. If you just started the program or switched to the test   
  builder, you can choose Create a New Test using the QuickTest wizard from the Startup menu.

 2. Enter the test title and click the Next button.

 3. Double-click a folder (if necessary) to display a list of question banks.

 4. Choose the question bank(s) from which you want to select questions.

 5. Click the Folder button to identify the location of the files if no question banks appear in the list. If you assigned  
  a password to the question bank, you will be prompted to enter the password before you can continue.

 6. Identify how many questions of each type you want on the test. If prompted, enter the number of matching   
  groups you want the wizard to use when it selects the matching questions you requested.

 7. Review the test summary and then click Finish to complete the process.

 8. When you click the Finish button, ExamView® selects the questions based on your responses and displays   
  them in the test document window.

After the program displays the test, you can edit existing questions, create new questions, select additional questions, 
customize the appearance of the test, save your work, or print the test. To default the number of multiple choice 
selections after the test is created, hold the CTRL key and press the J key on the keyboard. Place a mark in the box 
next to Change the Number of Multiple Choice Items and select a number.

 

15
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HOLT Language Arts  Technical Support 800.323.9239 

CreAting your own new test

 1. Choose the option to Create a New Test on the startup screen. 

 2. Enter a test title and then identify how you would like to choose questions from 
     the Select menu. You may add questions to the test by using one or more of the   
           question selection options: Randomly, From a List, while Viewing, By Criteria, By 
     Standard, or All Questions.

       
       

 3. Choose your method, and a window will appear for  
     you to choose the question bank(s) from which you  
     want to select questions.  You may select questions.  

 4. For example, if you choose while Viewing, the banks  
     you selected will appear in the top window. You can  
     view all the questions in the bank and place a check  
     mark in the box to the left of each test item you want to  
     include in your test.

 5. When you’ve finished, click on the Finish button at the  
     bottom of the screen to load the questions into your test.

Customizing your test

After you create a test, you can customize the appearance of the test by 
changing the order of the questions, editing test instructions, specifying 
the font and style for selected test elements, and choosing whether to 
leave space for students to write their answers directly on the test. The 
changes you make to the questions will not change the original question 
bank. Your changes are made only to the copy of the questions on the 
test you just created.
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eDiting A test Question
 1.  Highlight the question to edit in the test window.

 2. Click the Edit button located at the bottom of the test window or double-click the question to display an editing  
  window.

 3. You can now edit the question, change the answer, update the narrative, insert a graph or equation, or modify  
  the question information (objectives, difficulty code, reference, topic, or notes). See the Entering/Editing   
  Questions help topic for more detailed instructions.

 4. Click the Record button to accept the changes you made to the question. The program applies the changes only  
  to the copy on the test. The original question in the question bank is not updated.

Tip: Use the Question Bank Editor to permanently change a question or to add a new question for use on other tests.

Deleting A test Question
 1.  Highlight the question to delete.

 2. Click the Delete button located at the bottom of the test window.

 3. Confirm that you want to remove the question from the test.

Important: Removing a question you selected from a question bank does not affect the original question. However, the program  
will permanently delete any new question you may have created and/or a question you have edited.

Tip: Use the Clear Selections command to quickly delete all questions or to remove questions you selected from a particular 
question bank. To remove an entire question type, select the desired type and click the Delete button.

CreAting A new test Question
ExamView® adds the new question to the current test only. 

 1.  Click the New button located at the bottom of the test window or press CTRL+N .

 2. If prompted, specify the type of question to create.

 3. Enter the new question, answer, and information (optional). See the Entering/Editing Questions help topic for more  
  help. 

 4. Record the new question.

17
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HOLT Language Arts  Technical Support 800.323.9239 

reorDering test Questions
 1. Choose Reorder from the Question menu.

 2. Click and drag an individual question, a question type group, or a narrative group to the new location in the list.  
     You can also press CTRL+UP ARROw/DOwN ARROw to move the highlighted question.  

	 	 rules:
  + You can move a question only within the same question type.
  + To move an entire question type group (e.g., multiple choice), click on the question type and drag it to the 
   desired location.
  + You can move a group only to certain places in the list. The insertion bar appears as a thick line to indicate where  
   you may move the question group.
  + Questions attached to a narrative can be moved only within the same narrative group.
  + A question that is not a part of a narrative group cannot be moved into that group. Likewise, you cannot move a 
   question linked to a narrative outside of the group.
  + Matching questions can be moved only within the same matching group.

 3. Repeat Step 2 for each item you want to move.

 4. Click OK to update the current test.

sCrAmbling test Questions 

You can use the Scramble option if you want to randomly arrange the questions on a test. This option permanently changes   
the question order on a test.

 1. Choose Scramble from the Question menu. The Scramble option is different from the Reorder command in that  
  the Reorder command lets you move questions one at a time or in a group. You can also move them exactly where  
  you want the questions to appear. With the Scramble option, the program randomly rearranges the questions. If  
  you prefer, you can automatically generate different versions when you print a test.

 2. Choose one or more of the scramble options: Sections, Questions, or Choices.

 3. You may assign a new test ID (A -Z) each time you scramble the questions.

 4. Click OK to scramble the current test.

When you have finished creating your test, you can print it and/or save it. Choose File>Print to print a test. You may 
choose how many copies of the test you want, whether you want all the copies to be the same, whether you want to 
scramble the questions and the multiple choice options. If you scramble the questions, ExamView® will print a custom 
answer sheet for each variation of the test. An identification letter (A-Z) for each version will appear in the upper right-
hand corner of your test and answer key. You can change the header under Test from the drop-down menu.

18
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Mind Point 
Quiz Show

I.   Install  MindPoint Quiz Show (from a separate CD).

II.  Copy the Question Bank from ExamView:

1. Go to                     then                            and open your C: Drive

2. Scroll down until you find                              Double click to open the folder.

3.  Double click on                     Right click on the Holt Literature File 
     you wish to use and then copy the file.  (You may want to copy all of
    the files listed).

III.  Paste the question bank into MindPoint Quiz Show:

 1.  Hit the                 two (2) times to get to the C: drive list of folders.

 2. Open                                 and scroll down until you find                    .                   

.

 3. Open                         , open                           ,and then open                     .

4.  Right click and paste the question bank into the Question Set.

HOLT Language Arts Technical Support 800.323.9239
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Online
  Product
  Registration

registering teACHers For Premier Online editiOns AnD resourCes
To set up a User Name and Password, please do the following:

 1. Go to www.hrw.com/register

 2. First time users, select Teacher in a US School from the drop down menu. Click Register.

 3. Enter your contact information. Click Register. PLEASE NOTE: You will select your own User Name and    
     Password. 

 4. Select your school from the drop down menu. If your school is not listed, click      
            Help. If your school is new, it may not be in the system yet. You will have the  
     opportunity to submit a request to have your school added.

 5. Enter the ISBN number from the Teacher’s Edition of the first product you would like  
     to register. You will be able to register other programs or texts later. You can find   
     the ISBN located on the back of your Teacher’s Edition. Do not type the dashes.

 6. Enter the randomly selected security word as requested. PLEASE NOTE: The word   
     will be from a heading or paragraph from the sections found only in the Teacher’s  
     Edition, not student pages.

 7. Record your user name and password:   User name: ______________________________

         Password:  ______________________________

 8. To add programs to your registration, in the space provided in the upper left-hand corner 
     (blue section), simply enter the ISBN of the new text and repeat Step 6.

 9. Log in at http://my.hrw.com.

step 2

step 5

step 6

step 8
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HOLT Language Arts  Technical Support 800.323.9239 

registering stuDents For ACCess to Premier Online editiOns
To set up a User Name and Password for each of your students please do the following:

 1. Go to http://my.hrw.com and log in.

 2. Click on Add a Class under the Learning Management Center on the right.

 3. Type in the required class information for the class you are adding. Click Add. 
     PLEASE NOTE: Don’t forget to check the box next to the textbook(s) associated 
     with the class.

 4. Select the One Log In/Password box to determine if the student is already registered.

 5. If you see the name of the student(s) that you would like to add to your class in the My 
     School box on the left, select the student’s name and click Add. To select multiple names, 
     hold the Control key down while selecting. You should see the names appear in the My 
     Class box on the right. If you located all of your students, click Done to save your   
     changes. If you need to add additional students, repeat Step 5.

 6. If you do NOT see the name(s) of the student(s) that you would like to add to your class, 
         select the Add New Students button at the bottom of your screen.

 7. Choose the number of students you would like to add from the drop down menu. The  
     screen will refresh. This might take a moment. PLEASE NOTE: You can include the No  
     Child Left Behind settings by selecting Add NCLB Settings Now. At the bottom of the screen, 
     you will find the fields to enter the names and NCLB information of your students.

 8. Click Add at the bottom of the screen.

 9. Your student(s) now have a randomly generated User Name and Password. 
     For a printable version of your class roster, click Printable Version or go to 
     View a Class Roster under the Learning Management Center.

 10. Edit, Delete or Add individual students or classes by selecting  
      the appropriate task under the Learning Management Center.  
      The Learning Management Center is always located on the  
      right-hand side of your main subscriptions page.

 11. Instruct students to login at http://my.hrw.com.

 NOTE:  Students never register themselves for their 
    online textbooks.

step 3
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Novel Wise
     Writers’ Lives
          Graphic Organizers

Novel Wise,  Writers’ Lives and interactive 
Graphic organizers are found on the Teacher’s 

Online Textbook home page

Novel Wise - online offers additional teaching 
materials including: activities, assessment 
materials, and PowerPoint presentations.

Writers’ Lives - online presents new information 
about favorite authors including what they wrote, why 
they wrote, and little known facts about their lives. 
Includes audio and video.

Graphic Organizers - online provides visual 
resources in pdf.format. Each graphic organizer 
includes suggested uses and lesson plans for reading, 
writing, and differentiated instruction.

17



Holt
 Online
  Assessment

Holt Online Assessment is an online program that allows you to assign online work and content to students via the Internet  
and view student performance via a variety of reports.

Assigning Assignments or tests witH Holt online Assessment
1. Log in to your Holt account at http://my.hrw.com.  You must already be registered with Holt.

2. Under the Learning Management tools on the right side, under Assignments, select Assessment.

3. The main screen of Holt Online Assessment provides tabs to go to access your Assignments, Calendar, Reports, and  
    Preferences.

4. On your first visit, set your preferences by clicking on the Preferences tab.

5. To assign a test or activity, click on Assignments.  You will need to select your class and book, choose the category Tests  
    and Quizzes, and click on the Submit button

6. Assessments available will be listed.  You may use the links to View or Assign an assessment.

7. Verify the testing options on the pop-up window and then click Submit. Your test has been assigned and is now available  
   for student completion

8. Students log in to their online account and click on the link View Assignments to access the test.

9. After students complete the assignment, you may generate reports using the Reports tab from the main screen of   
   Holt Online Assessment.

uploADing An eXAmView® test
You may upload a test in you created in ExamView® for students to take online.  The system will automatically score objective 
questions. You may include open-ended questions; the system will prompt you to score them when students have finished. 

PLEASE NOTE: The upload feature works best if you are NOT logged in to Holt Online Assessment at the time of uploading 
a test.

For more information, please see page 19 of this document.
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using eXAmView® 5.0 to publisH tests to tHe Holt testing serVer
 1. Create your test in ExamView® 5.0. 
  Please Note: Computer technology can grade closed-ended items that you include in your tests such as: multiple   
  choice, true/false, yes/no, short-response fill-in-the-blank, and matching. Short answer questions must be graded 
  by the teacher.

 2. When you are finished creating your test, choose File>Publish Internet Test.

 3. Name or re-name your test, if you wish, in the field labeled Step 1. In the dialogue box’s 
    Step 2, select Publish Test to Holt Testing Server (not ExamView® Testing Server).

 4. Log in. Enter your Holt Online User Name (Instructor ID) and Password and click Next. You will see a progress bar   
     informing you that your user name and password are being validated. You will also see when your test has been   
     successfully uploaded.

step 2

step 3

step 4 19
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 5. Launch your Holt Online Learning subscription page by entering your Username and Password at    
       http://my.hrw.com or go to www.go.hrw.com and click on Online Textbooks.

 6. Manage assignments. When your subscription page appears, go to the     
    Assessment link on your Learning Management Center (right column).

 7. Associate.  The uploaded test will need to be associated with a text.  From the main screen of  
    Holt Online Assessment, choose the Assignments tab.  Select your class and book, choose the  
    category Unassociated Uploaded Tests, and click on the Submit button.  Click on the Associate  
    link, choose the book to which to associate this test, and click Submit. 

 
 8. Assign. Choose the category Teacher Uploaded Tests, and click on the Submit button.  
    Click Assign to assign the test.

 9. Configure. Verify the testing options on the pop-up window and then click Submit. Your test has been    
       assigned and is now available for student completion.

 10. Inform your students to log in at http://my.hrw.com with their User Names and Passwords. They can navigate  
      to their assignments from their Holt Online Learning Home Page by clicking the View Assignments link under   
                their online program. Finally, students can navigate to their personal performance reports by clicking the Progress  
      Reports link. 

step 5

step 6

20

step 9

step 7
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Holt
Online Essay 
       Scoring

step 5

step 2

using Holt online essAy sCoring

Congratulations on your purchase of a Holt program with Holt Online Essay Scoring. If teachers have already registered 
themselves and their class, they may use the following steps to set up Holt Online Essay Scoring.

stuDent use

 1. Students log in to their online account.  They should go to http://my.hrw.com, and then click     
     on the “Holt Online Essay Scoring” link beneath the picture of their book.

 2. Students choose a type of writing prompt (persuasive, descriptive, etc.).

 3. Students choose a specific prompt from a list.

 4. The prompt will appear with a space in which to write. Students may use the links for  
     prewriting and writing tips, revision tips, or interactive graphic organizers.

 5. Students click the “Get Your Score” button when finished with the essay.

 6. Students receive holistic feedback and analytic feedback. They also    
     have access to writing activities and a writing model. 
 7. When students exit Holt Online Essay Scoring, a separate window launches 
    stating that their essay with feedback has been saved.

21



HOLT Language Arts  Technical Support 800.323.9239 

teACHer use

 1. Log on to your online account the same way as students: go to http://my.hrw.com.

 2. Select the “View Student Essays” link located beneath the “Holt Online Essay Scoring” link for a given book.

 3. Select the class from the pull-down menu.

 4. Click the link to “View Essays” for a given student.

 5. The date of each student essay appears with a corresponding score listed.  To see the complete essay and feedback,   
     teachers click the date, which is a hyperlink. Another window will launch and show the essay. 

 6. Teacher may access a complete list of prompts from the “Teacher Support” link under the “Holt Online Essay Scoring”   
     link below a book.

22

step 5

step 3

teCHniCAl support
800.323.9239

teCHniCAl support
800.323.9239

Need assistance with registration?
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The Holt Calendar Planner helps you create a customized school-year calendar by using the same lesson plans that appear on the 
One-Stop Planner® CD-ROM. To set up your calendar, use the buttons at the bottom of the main screen in the order in which they 
appear: Settings, then Calendar.

setting

 1. School Start Date and School End Date - In the fields at the top of the screen, enter the first and last days of your school  
     year in the format (dd/mm/yyyy). Click the Show button to show the school days.

 2. Add Holidays - A checklist of common holidays appears on the left side of the screen. Click the check       
           box next to each to add that holiday to your calendar. Below the checklist is a toolbox for designating other    
           “no-class days” on your calendar: Holiday, In-Service/Professional Development, and School Break. The 
     program will assume that you do not teach class on these days and will not assign lessons on the marked 
           days. Click on Clear to return your mouse pointer to white and to stop marking “no-class days.”

 3. Cancel, Next, and Help Buttons - CANCEL will open a window that asks you if you are sure you want to close  
     without saving. You can click YES to exit or CANCEL to return to the screen. NEXT will take you to the second step in  
     setting up your school year. HELP opens the file that contains these directions for the program.

 4. Set Class Times - This screen allows you to set parameters for the class for which you are creating the present   
     calendar.

  •   Class Times category - Click one of the radio buttons to indicate the type of schedule for this class: 
               Daily/Traditional - Choose this category if your class meets every day. Alternating Days - Choose 
                  this category if your class meets every other day. Custom - Use this category to manually choose the 
                  days a class meets by clicking the box next to the days of the week listed. You can choose multiple 
                  days from this list.

  •  For all three types of class time categories, you must also assign a class length by filling in the minutes in the  
    text field to the right.

  •  If you select Alternating Days, there is an additional text field to enter the Class Start Date. Enter the       
                   first day the class will meet.

  •  Name your Calendar/Class. A text field for assigning a name to your class calendar will appear 
                   at the bottom of the screen. (Example: 5th Period Literature Class)

Holt         
 Calendar    
    Planner
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CAlenDAr
After you have set up a calendar with the school-year dates and class times, use the Calendar screen to fill in the calendar with 
customized lesson plans by dragging groups of materials or individual items from the lesson plan pane to the calendar.

 5. Lesson Plan Pane - On the left side of the Calendar screen
     At the top of the pane is a drop-down menu for Lesson Plans as well as Student and Teacher Resources.   
      Double-click on items to expand or collapse sections of the lesson plans. Resources appear in blue;    
      double click a resource to open the appropriate PDF document. Drag items from the Lesson Plan pane to   
     your calendar. 

 6. Calendar Pane - On the right side of the screen

  •  Use the Month/Year drop-down menu at the top of the pane to view a different month within your school year.

  •  Use the Change View drop-down menu to change the calendar display: 9-, 8-, 6-week, Month, Week, or Day

  •  When in the Day view, click the Print Resources button to print all of the worksheets and other handouts   
      included in that day’s lesson plan.

  •  Once items are in your calendar, you can open and collapse sections the same way you do 
                 in the Lesson Plan pane. Day view allows maximum viewing area for that day’s lesson plan and resources. 

  •  When in the Month, 6-, 8-, or 9-week views, double-clicking on a specific day will take you to 
                 that Day view. Simply double-click on the Day view to return to the previous view.

 7. Customizing Calendar - Other options 
     To add or insert special assignments, or make additions to a day’s lesson plan, drag and drop the  
           items in the Day space on your calendar. You will be asked if you want to add or insert the item. 

  •  Use the Note button to further customize the Calendar pane. When you click on the Notes button, a 
    pop-up window will appear. You can use this window to insert your own text into the Calendar pane, 
    such as additional lesson plans for materials not included in the textbook, additional teaching notes, 
    or additional information about the pacing of a particular lesson. You can also use it to insert blank   
       days or to set aside days for review.
 
 8. Navigating - Previous and Next buttons allow you to navigate to the previous or next day, week,  
           month, etc, depending on your current view.

 9. Printing Your Calendar   

  •  The Calendar View option prints the Calendar pane of the view you are currently using.

  •  The Full Text Report option prints a text-only version of your current view. 

*If you are having difficulty installing or saving your calendar settings, it may be that you do not have the correct 
user privileges set for this program. To use this program, you must have Power User privileges, or have your 
administrator set the user data folder inside the Holt Calendar Planner folder to have read, write and modify 
privileges for users.
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Holt         
  PuzzlePro®

      Basics
builDing A puzzle

 1. Double click on the Holt PuzzlePro® icon on the desktop. In Windows, you may also navigate to the       
     Program folder using the Start button. The PuzzlePro® splash screen displays.

 2. Select the type of puzzle to be built from the Main Menu or the Puzzle Menu. 

 3. Follow the instructions near the top right-hand corner of the screen.

eDiting A bAnk, list or term
 1. Double click on the Holt PuzzlePro® icon on the desktop. In Windows, you may also navigate 
       to the Program folder using the Start button. The PuzzlePro® splash screen displays.

 2. Make a selection from the Vocabulary Bank menu.

plAying A puzzle
 1. Double click on the Holt PuzzlePro® icon on the desktop. In   
        Windows, you may also navigate to the Program folder    
        using the Start button. The PuzzlePro® splash screen displays.

 2. Select a puzzle from the Puzzle list and click OK.

 3. Enter your name in the dialog box that displays and click OK.

to ADD your own VoCAbulAry list
 1. Click on the Vocabulary Bank menu, and select Edit List.

 2. At the bottom of the window, chose the button Add List.

 3. The new list will have the default name of “New List 1.” You may change the name using the window 
           on the right.

 4. To add terms to your list, click on the Vocabulary Bank menu, and select Edit Term. Using the windows   
         on the right, enter your terms and definitions and click OK. Your terms are now available to build puzzles.
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Virtual
File Cabinet

The Holt Virtual File Cabinet is  a separate CD designed for EASE 
of use; all resources are Editable, Adaptable, Searchable, and 
Expandable. You will have many resources from grade 5-grade 12 
available to help your students learn grammar, usage, and 
mechanics. You can quickly browse through the entire library to 
find the exact resource you want.

You can filter by keyword, grade level, resource type and standards.
You can modify the search data, edit the resource, add a note or 
print the worksheet from this screen if you wish. You can add 
resources that you have created and that have worked well for 
your students.

Complete installation instructions for both Mac and Windows are 
found inside the front of the disc.  Easy to use instructions as well 
as a demonstration tour on found on the main login page.

HOLT Language Arts Technical Support 800.323.9239
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   my notes...

The Passion of Literature
          The Power of Learning
                   The Proven Program
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